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Video Production
Premiere CC
After Effects CC
Cinema 4D
Animation
Dragonframe
Sound Production & editing

Welcome to Media Stores.  This is a short guide in order to assist you 
in how to book out equipment, find out what is available, and also 
some basic guides on how to get started with the equipment.

Media Stores houses a large amount of equipment to assist you in 
the production and resolution of work throughout your studies.  It 
is a shared resource across the school, so equipment must be well 
looked after.  Failure to do so will result in account suspensions.

Introduction

Staff

Photographic Production
Capture One Pro 9
Photoshop CC
Media Stores
Studio Bookings

Photography &
Media Stores Technician
Dave.Clark@soton.ac.uk
02380 596987

Motion Graphics 
Technician
A.J.Baxter@soton.ac.uk
02380 598888

Enquiries The technician in charge of all equipment loans and bookings is:
David Clark - Dave.Clark@soton.ac.uk

David Clark

Adrian Baxter

i
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Media Stores is Open at the times below, Monday to Friday unless 
stated otherwise.

10.00 - 11.00 am
4.00 - 5.00 pm

Equipment loans are not available over the summer break.

Please have your University of Southampton ID card ready as it is 
required in order to loan out any equipment.

Opening
Times

Returning
Equipment

Equipment must be returned by 4.00pm on the agreed upon return-
by-date.  Equipment can be dropped off in the Photo Media Office 
next to Media Stores (W.1197).  There is usually a member of staff in 
this room between the hours of 9am - 5pm.

All memory cards and card readers must be returned at the same 
time as the rest of the equipment.

Visit bit.ly/wsatandcs to download a full copy.T&Cs

Late Returns You will be notified via e-mail that equipment is overdue and must be 
returned immediately.  Any prints queued to be printed at Creative 
Services will be put on hold until equipment is returned.
If you repeatedly return equipment late, your access will be revoked.

High priority equipment loans are for 3 days max.  This is non 
negotiable.  All other equipment is 7 days max.

Loan 
Durations

Information
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Nikon D810
Nikon D800
Nikon D610
Phase One XF 
+ Credo 80

Available Equipment

DSLRs

Digital
Cameras

Digital
Video
Cameras

Film
Cameras

Canon 5DS
Canon 1D mark iv
Canon 5D mark ii
Canon 7D
Canon 50D

Canon SX50
Canon SX40

Black Magic URSA 4.6K
Black Magic CC 2.5K

Mamiya 7ii 
Mamiya RZ67
Mamiya RB67
Mamiya 645

Shen Hao TZ45 5x4 Large 
Format view camera
Various 35mm film cameras

Canon SX20

Panasonic HMC-41e HD
Canon M306 HD
GoPro Hero 3 HD

Nikon
Lenses

Nikon 35mm f/2.0
Nikon 50mm f/1.8
Nikon 85mm f/1.8
Nikon 105mm f/2.8

Nikon 16-35mm f/4.0 
Nikon 24-120mm f/4.0
Nikon 80-200mm f/2.8
Nikon 70-200mm f/2.8



5

Canon
Lenses

Canon 24mm f/2.8
Canon 24mm f/1.4L
Canon 24mm f/3.5 Tilt shift
Canon 28mm f/2.8
Canon 35mm f/2.0
Canon 50mm f/1.8
Canon 50mm f/1.4
Carl Zeiss 50mm f/1.4 MF
Canon 60mm f/2.8 EFS
Canon 85mm f/1.8
Carl Zeiss 85mm f/1.4 MF
Canon 100mm f/2.8 macro
Canon 135mm f/2.0

Tokina 11-16mm f/2.8
Canon 16-35mm f/2.8
Sigma 17-35mm f/2.8-4.0
Sigma 20-40mm f/2.8
Canon 17-85mm f/4.5-5.6 EFS
Sigma 18-50mm f/2.8
Canon 35-70mm f/3.5-4.5
Canon 28-80mm f/3.5-5.6
Canon 55-200mm f/4.5-5.6
Canon 24-70mm f/2.8
Canon 70-200mm f/2.8
Canon 100-300mm f/5.6
Sigma 70-300mm f/4.0-5.6

Cine Lenses
(For video)

Canon 14mm t/1.5
Canon 24mm t/2.0
Canon 50mm t/1.5

Phase One
Lenses

Schneider Kreuznach 80mm f/2.8 LS
Schneider Kreuznach 120mm f/4.0 LS

Available Equipment

Flash 
Equipment

Bowens Gemini 500R battery kit
Bowens Gemini 500 mains
Bowens Gemini 250 mains

Light
Meters

Sekonic L308s

Canon 580ex ii
Nikon SB-910
Wireless Flash Triggers

Sekonic L758
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Tripods Manfrotto 804 RC2 (photography)
Manfrotto 700 RC2 (video)

Available Equipment

5-in-1 photo reflector
Colour Passport checker
i1 Screen calibration tool
iPads
iMacs (for exhibition only)

Audio
Recorders

Digital 
Projectors

TVs LG 32” HD TV + USB
ALBA 32” HD TV + DVD
Sanyo 22” HD TV + DVD

NEC NP-M402H
Mitsubishi FD630U
NEC V300X
NEC V260X
Sanyo PLC-XU301A

Vivitek D7180HD
Sanyo PDG-DXL2000

Zoom H2 voice recorder
Zoom H2n voice recorder

1920 x 1080 1.2 - 2.0x
1920 x 1080 1.4 - 2.0x
1024 x 768 1.9 - 2.2x
1024 x 768 1.9 - 2.2x
1024 x 768 1.2 - 1.9x

1920 x 1080 0.19x
1024 x 768 0.20x

Philips 9” TV + DVD
TV Wall mounting bracket

Misc. Wacom Intuous Medium Tablet
Kensington Security locks
Glidecam HD 4000
Matte Box

Vertical 
Digital 
Projectors
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Installing a Projector

Projectors only work well in a darkened room.  Additional 
lighting will affect the image and decrease overall contrast.  If 
working in a bright space, you should consider using a TV.

Use the link below to calculate projector distance and screen 
size: projectorcentral.com/projection-calculator-pro.cfm

Vertical projectors are useful when space is limited.  
However, they can exagerate defects in a wall.

Use the controls on the projector to correct image warping 
caused by the projector pointing upwards or downwards.

Rotate the feet, or use small shims to help balance the 
projector.  Make sure the horizontal line of the projection is 
correct.

Please use cable guard to prevent a trip hazard.

Do not impede the air vents.  Keep a space of at least 50cm 
around the projector to allow air cooling.

Dust can easily get inside the projector and cause damage.  
If there is a source of dust in the room you will not be able to 
use a projector from Media Stores.

Any advanced or specialist use of projectors will require a 
risk assessment.  Please contact your supervisor for more 
information.

Dark Space

Throw Angle

Vertical 
Projector?

Keystone

Level the 
Projector

Cable Guard

Ventilation

Dust-free 
Space only

Risk 
Assessment
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Preparing a USB drive for video playback

In order for video playback to run smoothly from a USB or SD card, 
it is best to use a blank drive with only the video files you wish to play 
on it.  You can run a command to help to remove any hidden files or 
folders that may cause playback and looping issues on a media box 
or TV.

Backup up the USB
1. Insert your USB drive into a 
Mac.
2. Duplicate the contents by 
dragging the icon, whilst holding 
down option/alt.

Delete all files
3. Double click to open the USB.
4. Drag all contents of the USB 
to the trash.
5. Right click the trash and click 
‘Empty Trash’.

Transfer your video
6. Drag only the video file(s) you 
wish to play onto the USB drive.
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Activate Spotlight
7. Activate Spotlight Search by 
clicking the magnifying glass 
icon in the top right of the 
display.

Open Terminal
8. Type in ‘Terminal’ and hit 
return.

Run the dot_clean command
9. Type in:
dot_clean
Then press space.

Drag your USB into Terminal
10. Drag the USB from the 
desktop to the Terminal window.  
The cursor will change to a 
green + icon if done correctly.

Execute the command
11. Press return.

It will appear as if nothing has 
happened, but Terminal has 
now removed all ._ files from the 
USB.

Eject your USB
12. Eject the USB drive by 
dragging the icon to the Trash.

Preparing a USB drive for video playback
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Media Players can play almost all types of video files.  In order to get 
them to work correctly it is worth noting there is a very precise order 
in order to get the device to function with a projector/TV correctly.

Media Players have an extremely low rate of failure due to very 
few mechanical parts. Often, the main reason for the media player 
appearing to be broken, or not responding is incorrect setup.

Using a USB Media Player

Preparing 
your usb 
drive

Playing your 
video files

Follow these steps to ensure a media player is set up correctly:

Connect the HDMI cable between the media player and TV/projector.
Insert the USB/SD card in to the media player.
Connect the power cable in to the media player.
Turn on the TV/projector. You may need to press the source button 
to connect to the right input.

You will now see a menu system appear on the TV/projector. Point 
the remote directly at the blue LED. You can then navigate to your 
video file.

Once the video starts playing, you can make it loop by pressing the 
repeat button until ‘repeat one’ is displayed. In this mode, the media 
player will loop this single file indefinitely.

Once the media player has been disconnected from power, it will 
need to be set up again.

Follow the steps on p8-9 on how to prepare your USB drive for 
video playback.

1.
2.
3.
4.

Loop?
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You might not be displaying the correct input. Most projectors and 
TVs have either a source or input button that cycles through all 
inputs or auto detects an input after being pressed.
If you are using an ALBA or Sanyo TV, follow these steps:

Locate the column of 4 buttons at the back left of the TV.
Hold the P/V AV button (3rd button down) until a menu appears on 
the screen.
Press + or – (1st & 2nd buttons) to select HDMI.

Disconnect the power cable from the media player, wait 30s and 
reconnect.

Make sure you are pointing the remote at the blue LED, no further 
than 40cm away. Try disconnecting the media player power cable, 
wait 30s and reconnect.
If these both fail, it may be the battery. Bring it to media stores for a 
replacement.

You might have exported your video file in an unreadable format. We 
recommend the following settings:
QuickTime H.264 // 1920 x 1080p // 24fps
 
You might be attempting to play a dot underscore (._) file. These are 
invisible files that OS X creates in order to store information about the 
original file. In Finder, they are invisible, but on a media player they 
are visible.
To remove these files, follow the instructions on p8-9 on how to 
prepare your USB drive for video playback.

Using a USB Media Player - Troubleshooting 

Screen is 
blank?

Screen is still 
blank?

Media player 
remote does 
not respond?

File can’t be 
played?

File can’t 
be played?  
Advanced

If the problems persist, please bring the USB drive to media stores 
so a technician can help you solve the issue.

Still not 
fixed?

1.
2.

3.
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The LG TVs have an integrated USB socket for video playback. This 
means no media player is required, allowing for a neater presentation 
of work.

If your video appears with a red X through the thumbnail, your video 
file is in an unreadable format. We recommend the following settings:
QuickTime H.264 // 1920 x 1080p // 24fps

Using an LG TV with USB playback

Preparing 
your USB 
drive

Playing your 
video files

Red X on 
thumbnail?

The LG TVs do not require a remote control; touch-screen buttons 
are next to the standby LED on the TV. Follow these steps to initiate 
playback:

Press power on.
Connect your USB drive.
Press INPUT until USB is selected and wait 2s.
Press OK on Movie List.
The file(s) you wish to play should be already selected. If not, use the 
vol-/+ buttons to select the correct file. Then press OK.

Your file(s) will now loop indefinitely.

Once the TV is turned off, these steps will need to be followed again.

Follow the steps on p8-9 on how to prepare your USB drive for video 
playback.

1.
2.
3.
4.
5.

Please follow the instructions on p11.Still not 
fixed?
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iSolutions

Dropoff.soton.ac.uk

Serviceline
Online

iSolutions are the University’s IT specialist support team.  They can 
help you with the following:

Eduroam WiFi
Keychain Access
MFD Printing
Print Account Top Up

iSolutions operate a ticket based system to manage workloads.
In order to receive any help you must have logged a ticket.  This can 
be done through two ways:

Phone: 02380 595656
Web: sussed.soton.ac.uk > Serviceline Online

Dropoff is a service that makes it easy for you to transfer files, up to 
32.6 GB, to single or multiple recipients.

Files are automatically deleted from Dropoff 32 days after you upload 
them, so you don’t need to manually clean up.

Anyone from outside of the university can also use the service, to 
transfer files to you.

This service can be especially useful if you are doing group work and 
need to transfer large files to multiple members of your group.  It is 
also useful if you forget your USB drive and need to transfer files.

Dropoff.soton.ac.uk

Dropoff

32.6GB Limit
Up for 32 days
Unlimited use
Free
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Making a looping DVD using Adobe Encore

1. Create a New Project

Open Up Adobe Encore
Click ‘Create New Project’

Authoring Mode: DVD
Television Standard: PAL

2. Import the video

Click the Project tab.
Press cmd+i to import your 
video.

3. Add to timeline

Select the video and press 
cmd+t to add it to the time line.
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4. Set actions to play video

Select the properties tab.
Set:

End Action
Override
Menu Remote

To link to your video by right 
clicking in each box and 
selecting Chapter 1.

Check properties

Once complete, it should 
look like this:

Making a looping DVD using Adobe Encore
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5. Set your video to auto-play

Select the Project tab,
then
select the Properties tab.

Right click Title Button and 
select Specify link.
Select your video and press OK.

6. Set remaining actions to 
play your video

Set:

Override
Main Timeline

To link to your video by right 
clicking in each box and 
selecting Chapter 1.

Making a looping DVD using Adobe Encore
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8. Begin Burning

Insert a blank DVD and click 
Build.

If you don’t have a blank DVD, 
they can be purchased from the 
University shop.

Your DVD will begin burning.

If you experience any problems, 
contact the Motion Graphics 
Technician.

7. Set to burn as DVD

Select the Build tab.
Format: DVD
Output: DVD Disc

7. Check for errors

Click Check Project.
Then click Start.

If there are any faults you will 
need to resolve them. 

Common Faults

If you drag a .mp4 / .mov / .avi file directly onto a 
DVD and burn it, the DVD player will not be able 
to play it.  The file must be rendered and burned 
correctly to the disc using Adobe Encore.

If your video plays but doesn’t loop, you will need 
to start again, as DVDs can only be burned once.  
You may have forgotten to set ‘End Action’ to play 
your video.

Making a looping DVD using Adobe Encore
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Below is a list of procedures that should be carried out before and 
after using a digital camera.  More detailed instructions can be found 
on p19-21.

For further information, please consult the manual, available from the 
manufacturers website.

Using a Digital Camera

Format the memory card
Formatting the memory card removes all previous images and 
folders, enabling you to use the entire capacity of the memory card.

Reset default settings
It is worth returning the camera to default settings, as the previous 
user may have adjusted something you are not aware of.

Clean the lens with the cloth provided
A lens with any dust or grease smears will not provide you with 
optimal images.  Images may be soft and blurry as a result.
Clean the lens by making a light clockwise motion from the centre 
until all dust and grease is removed.  Do not use any cleaning fluids 
as these may damage the coatings on the lens filter.

Format the memory card.
Reset default settings.
Clean the lens with the cloth provided.
Charge up the battery.
Make sure to recharge the battery, as the next user may need to use 
the camera immediately on a shoot.

4.
5.
6.
7.

1.

2.

3.

After use
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Select Setup MenuPress MENU Format Memory card
- OK

Press MENU Select 1st Settings 
Menu

Format Memory card 
- OK

Press MENU Select Settings Format Memory card 
- OK

Press FUNC. Press MENU Select Setup menu
Initialize SD - OK

Formatting a Memory card
N
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Press MENU Select Setup Menu Reset user settings 
- OK

Press MENU Select 3rd camera 
settings menu

Clear settings 
- OK

Press MENU Select Setup Menu Reset All 
- OK

Press FUNC. Press MENU Select Setup Menu
Reset All - OK

Resetting Camera Settings
N
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Select Setup Menu
Select Language

Select 2nd Setup Menu
Select Language

Select Language

Changing a Camera’s Language

Press MENU Select English 
- OK

Press MENU Select English 
- OK

Press MENU
Select Setup Menu

Select English 
- OK

Press FUNC.
Press MENU

Select Setup Menu
Select Language

Select English 
- OK
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Using a Zoom H2/n Voice Recorder

Timecode
Volume Monitor

Monitor / Record

Headphone volume

Microphone gain

Microphone gain

Monitor / Record

Headphone volume

Timecode

Volume Monitor

Zoom H2

Zoom H2n
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Charge the AA batteries fully before use.  If you are using the audio 
recorder for a long time, connect the mains adapter to keep it 
powered.

Format the SD card through the menu.
Menu > SD Card > Format > Yes

Set the record mode to WAV 48KHz/16bit for video
Set the record mode to WAV 44.1KHz/16bit for audio only.
Menu > Rec. Mode >

Check recording volume by pressing the record button once.  You 
are not recording, note the timecode is at 00:00:00 - You are just 
monitoring the audio which can be seen on screen.

Adjust the recording volume via the MIC GAIN switch on the right 
hand side of the device.

Press the record button a second time to record, and once more to 
stop.  Make sure the timecode is rolling and that there is a circle with 
REC next to it on screen.

Try not to touch the Zoom voice recorder when in use as it will pick 
up unwanted sounds.

Background noise will be recorded.  Try to dampen this out.  It is 
best to use headphones to check this.

Charge 
Batteries

Format the 
device

Record mode

Check Levels

Tips

Using a Zoom H2/n Voice Recorder
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Studio 1 provides all of the equipment (minus DSLR) required 
to produce high quality studio photographs.

You can book Studio 1 and Studio 2 together to utilise both 
spaces together, providing you with a larger working area.

Facilities

Studio 1

Bowens Quad X
9ft backdrops
Tethered iMac
Capture One Pro 9

Induction required

Studio 2

Bowens Quad X
9ft backdrops
4ft backdrops
Magnetic Wall
Tethered iMac
Capture One Pro 9

Induction required
Studio 1 provides the same equipment as Studio 1.

Studio 2 also contains a shorter backdrop system, suited for 
working on still life and table top photography.  There is also 
a magnetic white board underneath the shorter backdrop 
system.  This allows prints/textiles to be hung on a wall and 
photographed.
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Copy Studio provides a near-perfect lit setup for producing 
high quality images of two dimensional work.  Copy Studio is 
best used for photographing sketchbooks, publications, and 
textiles.
For more creative work, we recommend Studio 1 + 2.

Image Lab provides a space for serious photography work.  
The lighting is daylight balanced and the monitors have been 
calibrated to provide a perfect environment for working on 
anything photographic.

This space is only for photographic work.

Image Lab

7 Workstations
7 Calibrated monitors
Hasselblad X1 Scanner
Epson 4900 Inkjet Printer
Magnetic Viewing Wall
Communal work area
Capture One Pro 9
Photoshop CC

Induction required

Copy Studio

36MP DSLR
Flash Lighting
2D work: 1.0 x 1.5m max
Capture One Pro 9
Copy stand with lighting

Induction required

Facilities
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Video Studio is similar to Studio 1 and 2, but the lighting 
equipment is different.  The Video studio houses continuous 
LED and Tungsten lighting, a still life table, and dragonframe 
stop motion software.

Use this studio if you wish to produce moving image.

Time Based Media (TBM) is for video editing, motion graphics, 
visual effects work, and 3D Games Design.

TBM is not the same as a Mac Suite as it contains high spec 
workstations and professional editing software.

Video Studio

Arri LED lighting
Arri Tungsten
12ft backdrops
Still Life table
Tethered iMac
Dragonframe Software

Induction required

Time Based Media 

25 iMacs
Adobe Premiere Pro
After Effects
Cinema 4D
Unity

Facilities
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Inductions

In order to use most facilities you will need to have attended the 
relevant workshop or induction.  This applies to everyone at WSA.
An induction serves two purposes:

To ensure the safety of yourself and those around you.
To familiarise and  educate you with new equipment, processes,              
and techniques.

If you have missed the inductions and wish to gain access to 
a facility, please contact your tutor and they can contact the 
relevant technician to see if additional inductions can be provided.  
Timetables are worked out well in advance so it can often be difficult 
to schedule in additional inductions.

PAT Testing

All electrical equipment must be inspected and tested by a qualified 
member of staff at WSA.  This includes all laptop chargers and 
phone chargers.

Please bring your equipment to any of the offices listed below.  
A member of staff can test your equipment and label it to be in 
compliance with University Health & Safety Policy.

David Clark  W.1197
Chris Carter  E.1049
Andy Reaney  E.1025
Leesa Miller  A.3003
Jane Smith  E.2031

Induction
Required

1.
2.

Missed 
Induction?

About

Staff
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Media Stores
Photo Studios 1 & 2
Copy Studio
Image Lab
Photography Office
Time Based Media
Video Studio

Technical Map

1.
2.
3.
4.
5.
6.
7.

7

4

3

2

1 5 
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